Shelf Logic® LABEL MAKER

Version 1





 
Release .00

( 2006  Shelf Logic Software Products.

Shelf Logic® is a registered trademark of Shelf Logic Software Products

All rights reserved.

Phone (845) 796-4242 • Fax (845) 796-4777

Table of Contents

1Table of Contents


3Table of Graphics


5Section 1 – Introduction


5Welcome to Shelf Logic( Label Maker


5System Requirements


6Section 2 – Installation


6Installing Shelf Logic® Label Maker


6Instructions for First Time Installations


6Shelf Logic Trial Version


7Registering Shelf Logic®


9Moving Shelf Logic® Label Maker


9Reinstalling Shelf Logic® Label Maker


10Section 3 – Getting  Started


10Starting Shelf Logic® Label Maker


10Creating a Label Maker


11Section 4. Opening  the  Planogram


11Specifying the Plan Name


13Section 5. Creating a  Shelf Label


13Starting a New Label


16Label Boxes


17Creating A Database Field Box


19Creating A Colored Box


22Creating A Bar Code Box


24Creating An Image Box


26Changing Label Boxes


27Saving A Shelf Label


27Section 6.  Printing  Shelf  Strips


27Printing A Label Maker


28Printing Channel Strips


28Printing Shelf Labels


28Setting the Label Format


29Setting Print Resolution





Table of Graphics

14Figure 1. The Registration Dialog Box


19Figure 2. The Main Screen


32Figure 3  Item Maintenance


41Figure 4. Front View
   Figure 5. Side View


41Figure 6. Top View


43Figure 7. Deleted UPC Code


43Figure 8. Changed Item Dimensions


45Figure 9. Field Labels


46Figure 10. New Database


47Figure 11. Existing Database


49Figure 12. Item Selection Window


50Figure 13. Database Filter Form


53Figure 14. Database Search Form


55Figure 15. Display Setup Shelf/Peg


58Figure 16. Display Setup Pallet Rack


60Figure 17. Display Setup Slat Wall


62Figure 18. Display Setup Vertical Slide


64Figure 19. Add Shelf


67Figure 20. Floating Shelf Setup


67Figure 21. Three Floating Shelves with 1 base shelf.


70Figure 22. Before Moving a Shelf – Smart Shelf Off


70Figure 23. Moving the Shelf Upwards – Smart Shelf Off


71Figure 24. Moving the Shelf Up More – Smart Shelf Off


72Figure 25. Before Moving a Shelf U[wards – Smart Shelf On


72Figure 26. After the Shelf Move – Smart Shelf On


73Figure 27. Before Moving a Shelf Down – Smart Shelf Off


73Figure 28. Moving the Shelf Downwards – Smart Shelf Off


74Figure 29.The Shelf is Moved Down More - Smart Shelf Off


75Figure 30. Before Moving a Shelf – Smart Shelf On


75Figure 31. After Moving a Shelf – Smart Shelf On


79Figure 32. Peg item on hook and same peg item on shelf


81Figure 33. Nested Baskets


82Figure 34. Drawing the Lasso


83Figure 35. The Group Formed by the Above Lasso


86Figure 36. Dragging Shelves with Smart Shelf On (left) and Off (right)


87Figure 37. Stack Number


88Figure 38. Smart Plan for Shelves Setup


91Figure 39. Smart Plan for Pegboard Setup


95Figure 40. Snap To


96Figure 41. Grid Setup


101Figure 42. Find Item


104Figure 43. Preferences Options Screen


105Figure 44. Preferences Database Screen


106Figure 45. Preferences Printing Screen


107Figure 46. Viewing Scale


108Figure 47. Scroll Bar


110Figure 48. A Note


110Figure 49. The Notes Dialog Box


114Figure 50. Save Plan


115Figure 51. File Open Dialog Box


120Figure 52. Print Planogram Options Sscreen


122Figure 53. Section Headers & Footers


123Figure 54. Create Image File


126Figure 55. Report Dialogue Box


129Figure 56. Sales Setup


131Figure 57. Sales Analysis Planogram


136Figure 58. Color Chart





Section 1 – Introduction

Welcome to Shelf Logic( Label Maker

Shelf Logic( Label Maker is a simple and flexible way to create Label Maker labels from your Shelf Logic planograms. 

There is a convenient visual drag and drop interface to create your label. You can move and resize bar codes, text, colored boxes and product photos.

Once these labels are finished, you can print them yourself or send them to professional printers to create specialized long Label Makers made with stiffer paper than most home printers will accept.

System Requirements

· PC compatible Windows 98, ME, NT, 2000, XP

· Pentium III Processor (or equivalent), 700 Mhz

· 96 MB of RAM (higher recommended)

· 16 MB Graphics Card

· 20 MB available hard disk space

· Shelf Logic Label Maker must be installed


Section 2 – Installation

Installing Shelf Logic® Label Maker

Instructions for First Time Installations 

(See upgrading section below if you currently run Shelf Logic® Express, Shelf Logic® Pro, or an earlier version of Shelf Logic® Label Maker.)

1. Download your Shelf Logic program from our website: www.shelflogic.com.

2. On the website, logon to the user section with your user name and password. You will see a link to download Shelf Logic Label Maker. When asked, save the file to disk. DO NOT open the file.

3. After downloading  Shelf Logic Label Maker, you will have a file called ShelfLogic_SS_Install.exe. Double-click on this file to start the installation.

4. Follow the installation instructions. 

The installation program will install Shelf Logic® Label Maker into a folder named “C:\Program Files\Shelf Logic Label Maker”. 

Shelf Logic Trial Version

When Shelf Logic is first installed, it automatically becomes a trial version. It needs to be registered in order to become a fully working copy. If the program is not registered, you will see this screen when the program starts:
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Figure 1. The Registration Dialog Box

( If you are using Shelf Logic as a trial version, then click on the “Continue with Trial” button.

( If you purchased Shelf Logic and wish to register it, then click on the “Register Program” button. See the next section for information on registering your program.

( If you haven’t purchased Shelf Logic and wish to do so. Click on the “Purchase Software” button and you will be taken to our website so that you can purchase the product.

(  You can click on the “Cancel” button to exit the program.

Registering Shelf Logic®
After installing the program (but before running it for the first time) you will need to register your Shelf Logic® software and obtain a program key code. You can register on our website or over the phone by calling our office. 

To start the registration, click on the  “Register Program” button. You will then be presented with a registration number. This registration number is turned into a program unlock key by calling our offices to get a program key, or by going to our web site and registering it online. The URL is:

http://www.shelflogic.com/register.htm
Keep the register dialog box open while you get the program key. If it is closed, you will get a different registration number each time you open the registration dialog box.

Once you get the program key, enter it into the program key field and click on the “Register Program” button. The program will then be registered and fully functional. This only needs to be done once.

The key code you will be issued is only valid for one installation so you will need to obtain a new key code for each copy of Shelf Logic® Label Maker  that you purchase. 

If you need assistance in registering your software, please contact Technical Support.


Note:  Please refer to the section on Removing Shelf Logic® which contains important information about moving, reinstalling, and re-registering your Shelf Logic® software.

Moving Shelf Logic® Label Maker

Please follow these instructions carefully in case you need to move Shelf Logic® Label Maker to a different computer or reinstall at a later date:

1. Copy the DataFile folder, Images folder, and Reader folder to a removable medium (floppy disk, zip disk, tape or network drive) before running the remove program. You will need to transfer these files to the new installation.

2. From the Windows Start Menu, select Shelf Logic® Label Maker/Move.

3. Shelf Logic® Label Maker will be removed from you computer and a removal code will be displayed on your screen. 
4. **You must write down this removal code and store it in a safe place or send it directly to help@shelflogic.com. ** 

Note:  You must have the removal code when you reinstall and reregister Shelf Logic® Label Maker.  This removal code is valid for only one reinstall so you must have a new removal code each time the software is moved.

Reinstalling Shelf Logic® Label Maker

1. Reinstall Shelf Logic® Label Maker following the instructions at the beginning of this section.
2. Copy your data files to C:\Program Files\Shelf Logic Label Maker\DataFile. 
3. Copy your image files to C:\Program Files\Shelf Logic Label Maker \Images.
4. Copy your zipped Reader files to C:\Program Files\Shelf Logic Label Maker \Reader.
5. Run Shelf Logic® Register according to the instructions above.

You will need both the removal code and the new registration number when contacting Technical Support.

Section 3 – Getting  Started

Starting Shelf Logic® Label Maker

Once installation is complete, you may begin using and learning Shelf Logic® Label Maker. From the Windows Start Menu, select Programs, then the Shelf Logic® Label Maker Program Group. Click the Shelf Logic® Label Maker icon to run the program, or double-click the Shelf Logic® Label Maker desktop icon.

Introduction

Shelf Logic® Label Maker is a powerful, flexible  label program that lets you create both custom labels and shelf strips. The labels can be printed on standard 8 1/2x11 labe sheets or printed as long shelf strips. The shelf strips are create as an image file that can be printed using larger printer or sent to a service bureau for printing.

You can create shelf strips for resets or channel strips for putting in the channels running under the shelves.

The labels and shelf strips can be printed for the entire planogram in planogram order, labels can be printed for a single shelf, or labels can be printed for  individual products right from the database, without a planogram having to be created.

The first step in printing labels is to select the source of the labels, either from a planogram or from a Shelf Logic product database. After selecting the source, you will either open an existing label or create a new label. The labels can now be printed and saved if desired for use at a later date.

Creating Label Maker

Creating a Label is done by putting several types of objects together to make the label. The objects are represented by boxes that be resized and positioned anywhere on the label. These are the available objects:

(  Product data from the Database

(  Free Form Text

(  Product Photo

(  Any Photo 

(  Bar Code

(  Colored Background

Product data from the Database

You can display information from any field in the Shelf Logic database. You can select the font, size and style and font color. This information changes with each different product printed.

Free Form Text

You can display any text in choice of font size and style and font color. This test remains the same on all labels printed.

Product Photo

This lets you display the product photo for each product label printed. This photo changes for each product printed.

Any Photo 

You can display any photo on the label. This can be a company logo ot other photo or artwork. This photo remains the same for all labels printed.

Bar Code

You can print a bar code for any field in the product database. There are a number of bar code formats supported.

Colored Background

This lets you create a colored background area on the label. For example, many labels have a yellow area where the product price is displayed.

Section 4. Opening  the  Planogram

Specifying the Label Source

When you start the program, you will see the main window, as shown below:
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The first step is to select a source for the labels. You will either print labels from a planogram or print labels for individual items in a database.

Printing Individual Product Labels from a Database

This lets you print one or more labels for one or more product in a database. These items don’t have to be on a planogram in order to be printed. Individual products can not be printed as a shelf strip, only as standard labels.

From the “File” menu, select “Open Database” or press CONTROL-D. and then choose the database you will be using. You can now proceed to open or create a label.

Printing Labels from a Planogram

This lets you print labels in planogram order.  You can print either standard labels or shelf strips from the entire planogram or a shelf at a time.

From the “File” menu, select “Open Plan” and then choose then planogram you will be using. The plan will open up and be displayed on your screen. Each shelf in the plan is numbered. 
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Above we have the demo Gondola plan displayed. Each shelf is numbered. You can print labels or a shelf strip for each shelf in the planogram or for a range of shelf of a single shelf. The shelf numbers let you specify which shelf or shelves to create Label Makers for.

It also specifies the order in which the labels will print.

Changing Shelf Order

Here the shelves are numbered starting from the bottom and going section by section. You can change the numbering so it goes from top to bottom and across sections if you wish.

On the “Edit” menu, select “Renumber Shelves”. You will see the following window:
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This lets you decide how the shelves are going to be renumbered.

Renumber Shelves from:

You can select “Top to Bottom” and the shelves will be number starting at the top of the planogram and working downward.

Renumber Shelves

This lets you select if you want to number within each section before going on to the next section or if you want to number across sections. So if you are numbering from top down, shelves are numbered top down regardless of the section that the shelf is in.

The following plan is numbered from top down across sections:
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You can see that shelf number 4 is in the second section whiel shelf 3 and 4 are both in section 1.

You can press the F7 key to zoom in and the F8 key to zoom out.

Section 5. Creating a  Label  Format

Creating a New Label

There are 2 kinds of labels you can create, standard labels that print on 8 ½ x 11 sheets of labels, or you can create shelf strips that are as long as the shelf.

In terms of creating the label, both are essentially the same, just the shelf strip layout is a little different from the standard label.

For the shelf strip, there’s a height for the overall strip and another height for the label that’s within the strip. For a label, there’s only the height of the label.

When defining a standard label format, you specify the number of labels across and down and the space between them. For the shelf strip, the labels are printed wherever there’s a product and there’s only one label ‘down’.

Creating a Shelf Strip

Once a plan or database is selected, you can create a new shelf strip label. From the “File” menu, select “New Label” and from the submenu choose “New Shelf Strip”. Or you can press CONTROL-T. You will see the Shelf Strip Setup Window, as shown below:
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Label Width – This is the width (in inches or cm) of each product label on the Label Maker. This is not the width of the entire Label Maker, just the individual label for a single product.

Strip Height – This is the height (in inches or cm) of the strip itself. The label height is the space left over after subtracting the top abd bottom margins. label on the Label Maker. 

Top Margin – This is the margin (in inches or cm) at the top of the Label Maker. This is usually underneath the top part of the strip holder and is not visible.

Bottom Margin – This is the margin (in inches or cm) at the bottom of the Label Maker. This is usually underneath the bottom part of the strip holder and is not visible.

The Label Height is calculated from the strip height and top and bottom margins. The label height is displayed and changes aech time the margins of strip height changes.

Strip Color – This is the background color of the Label Maker. Click on the Change Color button to select a color.

Label Color – This is the background color of the label portion of the Label Maker. Click on the Change Color button to select a color.

Load Label Format – This lets you load a previouly saved label format.

Save Label Format – This lets you save a label format so you can use it later.

Creating a Standard Shelf Label

Once a plan or database is selected, you can create a new shelf label. From the “File” menu, select “New Label” and from the submenu choose “New Standard Label”. Or you can press CONTROL-N. You will see the Shelf Label Setup Window, as shown below:
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Label Width – This is the width (in inches or cm) of each product label.

Label Height – This is the height (in inches or cm) of each label.

Labels Across

This is the number of label repeats across the page. It can also be considered as the number of label columns.

Label Rows

This is the number of label repeats down the page. It can also be considered as the number of label rows.

Top Margin

This is the distance in inches or centimeters from the top of the page to the top of the first row of labels.

Left Margin

This is the distance in inches or centimeters from the left of the page to the left edge of the first column of labels.

Vertical Spacing between Labels

This is the distance in inches or centimeters vertically between the labels. It’s the distance from the bottom of one label and the top of the one below it. If the labels touch as they do with most labels, then set the Vertical Spacing between Label to zero.

Horizontal Spacing between Labels

This is the distance in inches or centimeters horizontally between the labels. It’s the distance from the right edge of one label and the left edge of the one next to it. If the labels touch as they do with most labels, then set the Horizontal Spacing between Label to zero.

Click the OK button to save the label layout. This layout is saved and used the next time any shelf labels are used.

You can use several label layouts for a single shelf label if desired. 

Label Color – This is the background color of the label.

Load Label Format – This lets you load a previouly saved label format.

Save Label Format – This lets you save a label format so you can use it later.

You can  press the F7 key to zoom in on the label or press the F8 key to zoom out. The current magnification is displayed on the window caption bar.

Section 6. Creating the Label

When you finish defining the label format for either the shelf strip or shelf label, the Label Window will open up and look like the window shown below:
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For Shelf Strips: The blue area is the Label Maker and the white area is where the product label will go. 

For Shelf Labels: The blue area just represents the space areound the label and will not print as part of the label.

Label Objects

A Label Object is simply a rectangular box that represents and displays an element of the label. 

There are 6 elements.

(  Product Image Box

(  Image Box

(  Text Box

(  Database Field Box

(  Bar Code Box

(  Colored Box

The Product Image Box displays the product photo for the item, it there is one. 

The Image Box displays any photo and is good for company logos and other non-changing graphics.. The Text Box will display lines of text in your choice of font, style and color. 

The Database Field Box displays information from any field in the product database. 

The Bar Code Box can display the bar code representation of any database field in a choice of codes. The Colored Box is used to create a colored background area on the label.

Once a box is created, it can be resized and moved anywhere within the label.

Creating A Database Field Box

Let’s start right in and create a label. First we’ll create a database field to display the product price.

From the “Label” menu, select “Add Database field”. The Database Field Box Window for Text Boxes will open up so you can define the database field box, as shown below:
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This window lets you choose which database field to display, the font name, size and color and the text box alignment.

Field Name – Select a database field from the drop down box. For this label, we want to select the “Suggested Retail” field.

Adjust Height to Font Size – If this is checked, then the box height will be sized to fit the font.

Font – Here is where you can view the current font and select another if desired. By clicking in the “Change Font” button, you can select the font name, size, bold or italic and font color. The font selected is for this box only.

Align Horz – This lets you specify left, right or center alignment for this box. Choose from the drop down box.

After click on the OK button, the newdatabase field box will be created and placed in the upper left corner of the label, as shown in the figure below:
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We will now click on the box to Select it. When this is done, Handles appear around the box, as shown below:
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The Handles let you change the size and shape of the box. By clicking on any handle, you can drag the box into the desired shape. For now, we will click in the box and use the mouse to drag it to our final location.
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Our first label is in position. You can leave the text box selected, or click on the label background to Unselect the box.

Creating A Colored Box

Let’s create our next box. We will put a colored background behind the price database field box we just created.

From the “Label” menu, select “Add Colored Box”. You will see the Colored Box Properties Window, as show below:
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You can select the background color for the box and whether or not to have a thin black border around the box.

Background Color – This displays the current box background color. Click on the “Change Color” button to select any color for the box.

Keep Box Border – If this is checked, the box will have a thin black border around the colored box.

We will click on the Change Color button and select a yellow background color. When we click on the ”OK Button”,  the new colored box label will be created and placed in the upper left corner of the label, as shown below:
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Now we will select the colored box by clicking on it with the left mouse button.
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We’ll click on the colored box with the left mouse button and drag the box into position:
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Now we will resize the colored box. We will click on the box handle at the lower left of the box and drag it to change the box shape.
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Our colored box now cover the right part of the label and acts as a background for the price database field box.

Creating A Bar Code Box 

Our next box will contain a bar code. Select the “Label” menu and choose “Add Bar Code Box”. The Bar Code Box Window for Bar Codes will open up and is shown below:
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You can select any database field and the type of bar code.

Field Name – This is a drop downbox that has a list of all database field names. Select one for the bar code. In this case, we’ll select “UPC Code” as the field that will be displayed in the bar code.
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Bar Code Type – This is a drop down box with a list of available bar code types.

When we click on the OK Button, our Bar Code Box will be created and placed in the upper left corner of the label, as shown below:
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We’ll now click on the Bar Code Box with the left mouse button and dragged into position, then resized.
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Now we’ll add one more text box displaying the Item Name field.
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Creating An Image Box 

Our last type of box is the Image Box, which displays any photo or the photo image for the product. Select the “Label” menu and choose the “Add Image Box” selection. The Add Image Box Window for Image Boxes will open as shown below:
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Image Source

Choose the type of image you want to display. If you check “Product Image”, then this image box will display the product photo for each product.

If you select “From Image File”, you will be able to specify the image you want to display on the label. You can click on the “Browse” button to help you find your image.

You have two choices here about how you want to align the photo image within the borders of the Image box.

Align Horz - This is a drop down box that lets you determine the horizontal alignment of the image within the box borders. You can choose left, right or center aligned.

Align Vert - This is a drop down box that lets you determine the vertical alignment of the image within the box borders. You can choose top, bottom or middle aligned.

In this example, we choose a centered horizontal alignment and a bottom vertical alignment.

When the OK Button is clicked, the Image Box will be created and placed in the upper left corner of the label, as shown below:
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If you click on the image as shown below, you can see the Image Box and how the image is aligned to the bottom of the box, as specified.
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As the Image Box is resized, the image is also resized to fit the box. The image proportions are maintained to prevent distorting the image.

Changing Label Boxes

You can change the properties of any label box by double-clicking on it. The properties will be displayed in the Label Window and you can change them. For example, you can change the font size in a text box, the alignment in an image box, etc.

In our current label example, let’s change the price database field box and make the font larger. We’ll double-click on the price database field box and the Database Field Window will be displayed:
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We’ll click on the “Change Font” button and make the font 28 point in size and bold in style. Since we are displaying a number here, the price field, we will also specify right alignment for the database field box. After clicking the OK button, the database field box looks like this:
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One more final adjustment of the product image box. The Image box has been made wider and the image is now centered within the box borders. 
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Our label is now ready to print and save.

Saving A Shelf Label

Labels can be saved and loaded at a later time for printing and possible modifications. To save a label, select “Save Label” from the “File” menu. You will be asked for a name for the label and a location where it will go. An extension of “SSL” is automatically added if not specified in the name.

Section7.  Printing  Labels

Printing A Label

When printing labels using a planogram as the source, you can print labels for all shelves, a range of shelves, a single shelf, or you can print individual product labels from the planogram database. If you are printing labels from a database, you can only print individual product labels.

Printing A Shelf Strip

Select  “Print Labels” from the “Print” menu or press CONTROL-P. You will then see the Print Window, as shown below:
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You can print labels for all shelves on the planogram or a range of shelves. The shelves are numbered on the Plan display so you can tell which shelves you want to print.

Print All Shelves

Checking this will print a shelf strip for each shelf on your display on which there are products. When you click the “Print Labels” button, you will be asked for a label name. For each shelf, “-ShelfXXX.bmp” is appended to the label name. The “XXX” is replaced by the shelf number. 

For example, if your shelf strip is named “Dairy Section”, then the resulting image files will be named “Dairy Section-Shelf001.bmp”, “Dairy Section-Shelf002.bmp”, “Dairy Section-Shelf003.bmp” and so on until all shelves are done.

Print Range of Shelves

Checking this will let you enter a starting and ending shelf number. Shelf strips will be printed for these shelves only. The naming convention os the same as when printing shelf strips for all shelves.

Print

Click on the “Print” button when you  are ready to print the labels.

For shelf strips, the labels are automatically sized to the shelf length so a 48 inch shelf shelf will have a 48 inch channel strip. Since this is too long for a conventional home printer, the shelf strips are printed to an image file. You can then take them to a professional printer to create

Clicking on the “Print Label Maker” button will let you save the Label Maker as an image file so it can be printed using commercial printers.

The standard Windows Save Dialog box will appear. You can enter the location of the saved image, the name of the image and the type of image. 

The image types available are:

.BMP

.DCX

.JPG

.PCX

.PNG

.TIF

When the images are saved, the shelf number is added to the end of the image file name. If you enter an image name of “TEST’ (and image type of .jpg) and you have three shelves on the plan, you will get three image files, “TEST-Shelf001.jpg”, “TEST-Shelf002.jpg”, and “TEST-Shelf003.jpg”.

Printing Shelf Labels

For Shelf Labels, clicking on the “Print” button will print the Shelf Labels on an 8 ½ x 11 inch sheet of labels.
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Print All Shelves

Checking this will print labels for all shelves on the planogram. The labels will be printed from left to right, top to bottom until the sheet of labels is full. The sheet will be printed and the printing will again start with the first label in the upper leftof the sheet.

Print Range of Shelves

Checking this will let you enter a starting and ending shelf number. Shelf labels will be printed for these shelves only. 

Print Individual Products

Checking this will let you print product labels for one or more products by entering the UPC Codes for those products. Enter one or more UPC Codes, Press the “Enter” key after each UPC Code is entered.

Find

When “Print Individual Products” is selected, the “Find” button will be enabled, as shown below:
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Clicking on the Find button will let you find product based on any field in the database

See the section on Finding Products to Print.

Print

When you click on the Print button, the label will begin to print.

Setting Print Resolution

You can set the desired print resolution using the Print Resolution selection from the Print menu. You will see the Print Resolution Window, as shown below:
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You can enter the desired resolution in dots per inch (DPI), then click OK to save this. The resolution remains the same for all labels until changed. It is saved and used the next time Shelf Logic Label Maker is used.

Printer Setup

From the Print menu, select Printer Setup to change printers.

Finding Products to Print

When printing labels for one or more product based on UPC Code, you can search for products based on any field. You can select one or more product matching your comaprison.

When you click on the Find button (from the Print Window), the Search Window will appear, as shown below:
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You can search for products based on any field in the database. You can search using several comparisons such as equal to, not equal to, starting with, etc.

Available Comparisons


=

Equal to  

<>

Not equal to 

>

Greater than 

<

Less than 


>=

Greater than or equal to 

=>

Greater than or equal to 

<=

Less than or equal to 

=<

Less than or equal to 



word* 

Starts with 

*word 

Ends with 

*word*
Contains 


Examples of Boolean Operators:

=123

Equal to 123 

>123

Greater than 123

<123

Less than 123


>=123

Greater than or equal to 123

=>123

Greater than or equal to 123

<=123

Less than or equal to 123

=<123

Less than or equal to 123

<>123

Not equal to 123



ABC* 

Starts with ABC

*ABC 

Ends with ABC

*ABC*
Contains ABC


To seach by a field, enter the search word into the field on which you want to compare. For example, in this next window, we are searching for products equal to “grocery”.
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When we click on the “Find” button, the first product with this comparison is displayed, as shown below
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At this point, the user has several options.

Find Next – Clicking this will locate and display the next product matching this comparison

Select and Find Next – This selects this product and continues the search for the next product matching this comparison. This is used to select more than one product record.

OK – This select the product displayed and exits back to the Print Window.

Cancel – This cancels the search operation.

When you click OK, the UPC Code(s) will be display back in the Print Window.
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Here we’ve selected a single UPC Code to print labels.

You can search for products based on two or more fields. In this case the “AND” comparison is used. So if you have “=grocery” in the category field and “>1.00” in the cost field, you will get those products that have both a category of grocery AND a cost of more than 1.00.

Section 8.  Menu Summary

This is a summary of all menu commands. Not all commands appear at all times but are listed here for the summary. The Window displaying the label and the plan have different menus.

Plan Window

File

Open Plan – This prompts you for the name of a plan to open.

Open Database – Choose this if you wish to print labels from a database. You will be prompted for the name of the database. It must be a valid Shelf Logic database used with Shelf Logic Master Edition version 14.

New Label


New Shelf Strip – This lets you create a new shelf strip.


New Standard Label – This lets you create a standard label that prints on 8 ½ x 11 labels.

Open Label – This lets you open an existing label.

Save Label – This lets you save the label.

Save Label As – This lets you save the label under a different name.

Exit – This will exit the Label Maker program.

Edit

Zoom In – This increases the magnification of the plan

Zoom Out – This decreases the magnification of the plan

Renumber Shelves – This lets you renumber the shelves on the plan

Label Window

File

The menu is the same as in the Plan Window

Edit

Zoom In – This increases the magnification of the label. 

Zoom Out – This decreases the magnification if the label

Zoom to 1x – This zooms back to normal 1:1 magnification.

Label

Add Image Box – This lets you add a product image or other image to the label.

Add Database Field – This lets you add information from the product database to the label.

Add Free Form Text – This lets you add any text to the label.

Add Bar Code Box – This lets you add a Bar Code to the label.

Add Colored Box – This lets you add a colored background area to the label.

Delete – This lets you delete a label object. Select the object and then you can delete it.

Print

Print Label – This lets you print the label or shelf strip

Label Layout – This let you change the label or shelf strip format

Print Resolution – This lets you change the print resolution

Printer Setup – This lets you change printers.

Shortcut Keys

CONTROL-A 
– Save Label As

CONTROL-B 

– Add Bar Code to Label

CONTROL-C 

– Add Colored Box to Label

CONTROL-D

– Add Database Field to Label

CONTROL-E 

– Open Database

CONTROL-F 

– Add Free Form Text to Label

CONTROL-I 

– Add Image Box to Label

CONTROL-L 

– Open Label

CONTROL-N 
– New Standard Label

CONTROL-O 
– Open Plan

CONTROL-P 

– Print Labels

CONTROL-R

– Print Resolution (Layout Window)

CONTROL-R

– Renumber Shelves (Plan Window)

CONTROL-S

– Save Label

CONTROL-T 

– New Shelf Strip

CONTROL-Y

–Change Label Format

F7

 
– Zoom In

F8

 
– Zoom Out
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